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100 - Iconography 101 
You don’t have to accept every desktop icon that your Windows computer gives you to represent 
a file or folder. You can replace an icon with an existing graphic. 
Click Start, Programs, Accessories, and Paint. In Paint open any graphic file, though bitmap files 
work best (you’ll know them by their .bmp extensions). To ensure your new icon doesn’t lose its 
detail, don’t select a large picture. 
Choose "Save as" and rename the file, making sure you use ".ico" as the file’s extension, as in 
filename.ico. Save the file to a location on your hard drive where you can easily find it, perhaps a 
special folder you’ve created for odd files like these. Close Paint. 
Now right-click on one of the existing, boring icons on your desktop. >From the drop-down 
menu, choose Properties, then the Shortcut tab. Now choose the Change Icon button, then 
Browse. Find your newly created icon, double-click on it, then choose OK in both windows. 
Your new icon should now appear on your desktop, replacing the original. 
(Unfortunately, the Recycle Bin, My Computer and a few other icons that come with Windows 
cannot be changed this easily. You’ll need more complicated Cheap Tricks for them.) 
 
099 - Vertical integration 
Ever want to select a vertical block of text — like a column of figures — but Word only lets you 
highlight lines that go right across the page? 
The trick is to hold down the Alt key while you drag the mouse diagonally across the selection. 
(On a Macintosh, use the Option key instead of Alt). 
You can also do it with key commands alone. Press Ctrl, Shift and F8 together, then let go and 
use the arrow keys to extend the highlighted box. (With a Mac, use the Command key with Shift 
and F8.) 
 
098 – Secret desktop folder 
Remember our tip for displaying a folder of all your desktop files and folders? Click on Start and 
Run, enter a period and click OK? 
If you do this a lot, we can make it easier for you by setting up a button on the taskbar at the 
bottom of your screen that you can click when you want to see the desktop folder. Here’s how to 
set this up: 
1. Right-click Start and select Open from the context menu. This should open the Start Menu 
folder. 
2. In the Start Menu folder, double-click Programs to open that folder, and then StartUp. 
3. In the StartUp folder, right-click on a blank area and select New and Shortcut from the menus. 
4. In the space for the Command Line, type c:\windows\explorer.exe c:\windows\desktop – 
there’s a space only before the second c: and those are backward slashes. Click Next. (This 
command assumes Windows is stored in the directory named Windows. If not, substitute the 
name of your Windows folder for windows in both instances.) 
5. Name the file something profound like Desktop and click Finish.  
6. Back in the StartUp window, right-click the new Desktop icon and select Properties. 
7. Under the Shortcut tab, in the Run field select Minimized and click Close. 
The next time you start Windows, the Desktop icon will be on the taskbar. Click it at any time 
and you’ll get immediate access to all your desktop items in a separate folder. 
 



097 - DOS to order 
Do you find it too cumbersome to navigate in MS-DOS to the directory you want, especially 
with those weird truncated filenames? 
The solution is to find the folder in Windows first. Use Explorer or My Computer to go to the 
folder and select it. Then, while it’s selected, click on Start and Run, enter command and click 
OK. 
The MS-DOS Prompt window will open exactly at the directory corresponding to the folder you 
chose. 
 
096 - Make your desktop dance 
Your Windows desktop can shake, shimmy or do the lambada, once you know how to use a 
video clip as your wallpaper. 
You’ll need an AVI file (ending in the .avi extension), as well as Microsoft’s FrontPage (though 
you could try it with another HTML editor).  
If you don’t have an AVI file, you can always download one for free from shareware sites on the 
Internet. A large file with high resolution to cover your entire screen is preferable. 
Once you’ve located a video file you want to use, open FrontPage to a new FrontPage Editor 
window. In FrontPage Editor, look for the command to insert video. In Frontpage 2000 you’ll 
find it by opening the Insert menu, and clicking on Picture and Video. In FrontPage 97, look 
under Insert for Video. You might also find it under Insert and Active Elements. 
Insert your selected AVI file. When it’s placed, right-click on the image in FrontPage, select 
Image Properties or Picture Properties from the pop-up menu and, in the window that appears, 
select the Appearance tab. Put a check beside Specify Size and fill in the figures to make the 
image fill your screen (800 by 600 pixels for most 15-inch monitors).  
If you want the video to play continually, click on the Video tab and, after Loop, put a check 
beside Forever. Click Okay to close the Properties window. 
Save the file with an .html extension (for example, as desktop video.html) and close FrontPage. 
On a blank part of your desktop, right-click and select Properties from the context menu. Go to 
the Background page and use the Browse button there to locate the HTML file you’d saved. 
When you find it, click Open and make it your wallpaper. 
Click Okay to close the Display Properties window.  
To activate your desktop video if it is not already running, right-click on the desktop and select 
Play. You may have to reboot the computer to make it take effect. Then the video should run 
automatically. 
 
095 - Eudora who? 
Do you know who the email program Eudora was named after? 
You’d know if after you’d started using Eudora you’d continued letting those little tips appear 
every time you launched the program. The origins of the Eudora name is one of the tips. But 
there are many more practical items than this available. 
You can find them all by looking in your Eudora folder (likely under Program Files and 
Qualcomm) for a file named eudora.tip. Open it with your word processor. Voilà. All the Eudora 
tips in one text file.  
 



094 - Banish clouds and rectangles  
When you open Explorer in Windows 98 or Me, there’s a little graphic in the upper left corner, or 
in the upper left corner of the right pane if you use the two-pane layout. In Win98 it’s a cloud 
design and in WinMe it’s usually a set of colourful rectangles. 
This graphic is set in Win98 by the file wvleft.bmp, which is a hidden file in the Web folder 
inside the Windows folder. WinMe also has a cloudy .bmp file with that name but the rectangles 
graphic seems to come from another file, wvleft.gif, in the same folder. 
In either case, you can replace this graphic with whatever design you would like. 
Create a .bmp or .gif file in Paint or another image-editing program and save it as wvleft.bmp or 
wvleft.gif in the Web folder in place of the previous file with that name. (It may be a good idea 
to make a backup of the old file first, in case you want to restore it later.) 
When you create your graphic, be sure to make the bottom part of it lighter, so the information 
displayed in that corner of the Explorer pane will be legible. 
 
093 - Detect Web site data 
Want to know when a Web site was last modified? Or whether documents are secure on the site?  
If you use Netscape Navigator as your browser, when you are at a site you want to check out, 
just type about:document (with no spaces) in the place where you usually enter an URL (Web 
address) and hit Enter or Return.  
You’ll get all kinds of info about the site, including its structure and links to images. 
 
092 - Everybody out 
You have all kinds of folders and files open and you want to close them all. What’s the fastest 
way?  
Windows 98 and Me have an undocumented little procedure for this. 
Hold down the Ctrl key and click on each file or folder’s icon in the Taskbar across the bottom of 
the screen. The buttons will seem to depress but nothing further happens. 
Then right-click on one of these buttons and select Close from the context menu that pops up. 
All files and folders will close up at once. 
 
091 - Periodic navigation  
This is a little trick to navigate among Windows folders that old-time users of  DOS, the 
precursor to Windows, may recognize. 
Suppose you’re trying to find a document to open in a program like Word and you have to look 
in a folder higher than the one that’s showing in the Open dialogue box. You can click on the 
little yellow folder with the arrow pointing up near the top of the box, or you can try typing two 
periods (..) as the File name and pressing Enter. You’ll find that you’ve moved up one folder. 
Type in three periods (…) and you move up two folders - always one fewer steps than the 
number of periods. 
But that's not all. This also works in desktop folders if you have them set up to display like Web 
pages. To go to the parent folder of the one you have open, for example, type two periods in the 
Address line and press Enter. 
 
090 - Ordering Favourites 
You know in Internet Explorer you can arrange your Favorites in folders through the Organize 
Favorites command under the Favorites menu. But this is clumsy at best. If you are more 



comfortable working with real folders and shortcuts, you can handle this task more efficiently in 
Windows’ Explorer. 
Open Windows’ Explorer (right-click Start and select Explore) and navigate to the Favorites 
folder in the Windows directory. Under here you will see all the favorites listed as shortcuts, 
including a Links folder of favorites that appear on the Links toolbar in Internet Explorer. 
Move these shortcuts around, create new folders for them or delete them as you wish, and the 
effects will take place with your Favorites in Internet Explorer. 
 
089 - Cache flow 
Windows uses some of your computer’s memory as virtual cache which theoretically helps speed 
up certain tasks. However it can also drain memory that you need to carry out your own work. If 
you suspect you are losing too much memory to cache, you can set limits to it. 
This can be done by adding lines in the system.ini file. In Windows 95 or 98 you can open all the 
.ini files by clicking Start and Run, entering sysedit and clicking OK. In later Windows, you may 
need to run Notepad (Start, Programs, Accessories, Notepad) and open system.ini from within 
that program. It should be found in your Windows folder. 
In system.ini find the [vcache] section. Add the following two lines (substituting the correct 
number for the formula in the second line): 
MinFileCache=0 
MaxFileCache=Total MB of RAM / 4*1024 
For example, if you have 64 megabytes of memory (RAM), then the maximum amount of cache 
would be 64 divided by 4 times 1,024 = 16,384 kilobytes. The second line would therefore read: 
MaxFileCache=16384  
These lines set virtual cache to a range from none to one-quarter of your memory.  
Save the file and reboot for this limit to take effect. 
 
088 - Clear out, docs 
If you find Windows’ Documents list useful but would like to clear the contents every now and 
then, you can use the following simple tweak to the Registry to have the list wiped out every 
time you exit Windows. 
(Once again, if you are not used to Registry editing, you can find out all about it at www.WE-
Compute.com/registry.html.) 
Open the Registry Editor and head to HKEY_CURRENT_USER\Software\ 
Microsoft\Windows\Current Version\Policies\Explorer. Click Edit and New DWORD value.  
Right-click the value and select Rename. Type ClearRecentDocsOnExit and press Enter. 
Double-click the new value and set the value data to 1 (that’s the numeral one). Exit the Registry 
and restart the computer.  
Windows will now clear the Documents list whenever you restart or turn off your PC. 
 
087 - Show me the menu 
Do the new shortened menus in Word, Excel or other Microsoft programs since the 2000 version 
drive you nuts? Tired of having to click on the arrows at the bottom of menus to expand them to 
include the command you want?  
Well, you know you can always change this permanently. (Select Customize in the Tools menu 
and you’ll find the options you want.)  
But you can also call up the full menus quickly without making this permanent change. 



Just double-click on a menu heading and the whole shebang will appear with recently used items 
in relief. In fact, once you double-click on a menu, all the menus will open in full until you click 
elsewhere. 
 
086 - Belay that delay 
When you start Windows 98 or Me, it usually pauses for two seconds to allow for the detection 
of hardware that is slow to activate, but the vast majority of hardware doesn’t require this extra 
time. 
To get rid of this delay, first click on Start, Find, Files Or Folders, type in msdos.sys, tell 
Windows to look in C: and click Find Now. When you see the msdos.sys file appear, right-click 
it and choose Properties. If the Read Only and Hidden boxes are ticked, untick them. 
Click OK and then create a backup of this file just in case you encounter any problems. 
Next, right-click on msdos.sys again and choose Open With. Choose to use Notepad to edit the 
file. With the file open, find the Options heading and under this, add a new line saying 
BootDelay=0 or BootDelay=1 (that’s a zero or a numeral one), for no delay or a one-second 
delay. 
Close Notepad, saving your changes on the way. You should then change msdos.sys back to 
being a Hidden, Read Only file before you restart Windows. If you do encounter problems 
without the two-second delay, simply open up msdos.sys, remove the BootDelay line, then save 
the file again 
 
085 - Searching near and far 
Search engines on the Web are never as precise as you want, which is why you end up with 
108,295 hits when you plug in a single term to look for. 
Use multiple terms joined by AND, OR, NOT and NEAR to narrow down the search. 
In many search engines you use the word AND or a plus sign (+) to indicate you want to find 
sites that use both words, as in Bush + president.  
Use the conjunction OR to get sites that contain either of two words, as in Bush OR Gore. 
The word NOT or a minus sign (-) indicates you want sites that include one word but not the 
other, as in Bush NOT Gore. 
Employ the preposition NEAR to tell some search engines to find sites with the words close 
together. You might use president NEAR Bush to get a site about "President George Bush", but 
rule out sites that include both words appearing far apart, such as an item about how "President" 
Bill Clinton once told Republicans to stop beating around the "bush". 
 
084 - Insulting message 
With a bit of fiddling in Windows’ Registry, you can make an official-looking message pop up 
on a computer screen as the user starts Windows. 
To get into the Registry, hit Start and Run, type regedit and click on OK. (For more detailed 
instructions and precautions about editing the Registry, go to www.WE-
Compute.com/registry.html.) 
In the Registry Editor, navigate through the following keys: 
HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\Current Version\WinLogon. Right-
click on WinLogon and select New and String Value. Rename the string value that appears in the 
righthand panel LegalNoticeCaption and then double-click on it. In the Edit String box that pops 
up, enter a short title for the logon message you want to create and click on OK. 



Right-click again on WinLogon and make another new string value, named LegalNoticeText this 
time. Double-click on this string value and in the Edit String box enter the full message as you 
want it to appear. Click on OK. Close up the Registry Editor and reboot the computer. You 
should see the message. 
This is a great way to play a prank on a friend, to give them an official-looking insulting message 
when they log on. 
 
083 - Playing postman 
If you have Outlook 2000, you can uncover and play a cute little hidden game, 
Open Outlook, type Ren Hoek  (capitals are not necessary) in the Find a Contact bar at the top 
and press Enter. If you get a message saying no such contact can be found, click OK and 
continue. 
Under the Tools menu, select Macro and then, in the submenu, select Macros. In the Macro 
Name box, type OL2KROCKS (lowercase is okay) and click the Create button. 
When the About Microsoft Outlook window appears, hold down the Ctrl, Alt and Shift keys 
while clicking OK. 
You’ll be treated to a game in which you move a mailbox up and down with the Arrow keys to 
catch envelopes as they fly across the screen bearing developer credits. 
 
082 - No shutdown allowed 
Some people like to keep their computers turned on all the time. If you’re one of them or if you 
just want to keep others from shutting down your system for a while, here’s a trick for you. 
(It takes a Registry hack, so if you’re not familiar with Windows’ Registry, check out our 
instructions and precautions at www.WE-Compute.com/registry.html  first.) 
In the Registry, go to HKEY_CURRENT_USER\Software\Microsoft\Windows\Current 
Version\Policies\Explorer. From the Edit menu, select New and String Value. Right-click the 
new value in the right pane and select Rename. Type NoClose as the string’s new name. Next 
double-click on it to open the Edit String dialogue box. Enter 1 (the numeral one) as the value 
data and click OK. 
Close the Editor. 
Your system cannot be closed or restarted now through the usual Shutdown command. 
While this won’t make it impossible for people to turn off the computer, it should leave them 
scratching their heads for a few minutes. 
To re-enable shutdown, return to the NoClose string and change its value to 0 (zero) or delete it 
altogether. 
 
081 - Pop-up menus to order 
When you right-click on a folder, a context menu pops up giving you options such as Open, 
Explore and Find. But you can add almost any other command you like to this context menu. 
It requires a Registry tweak. If you are not familiar with editing the Registry, check the 
instructions and precautions at www.WE-Compute.com/registry.html. 
In the Registry, make your way to HKEY_CLASSES_ROOT\Directory\shell. Right click on the 
shell key and select New and Key. Rename the new key whatever you want the new command to 
be. For example, if we want to be able to launch Microsoft Word from folder context menus, we 
might enter Word as the key name.  



Then right-click the new key (Word in our example) and again select New and Key. This new 
key should be named Command. Click once on the new Command key and in the pane on the 
right side double-click on the Default string name. 
In the Edit String dialogue box, enter the path to the file as the Value Data. In our case, the path 
would be C:\Program Files\Microsoft Office\Office\Winword.exe, but you can make a path to 
any other program, file or shortcut on your system. 
Click on OK, close up the Registry Editor and press F5 to refresh the Registry. Right-click on 
any folder on the desktop or in Explorer and your new option will be available. 
 
080 - Transfer audio CD info 
If you use the audio CD player that comes with Windows and you’ve typed the titles of CDs, 
artists and song names into the program, then you’ll eventually need this tip. 
Suppose you replace your computer or upgrade to a new hard drive - you’ll have to enter the 
information for your CD collection all over again, won’t you?  
Not if you know about a little file called cdplayer.ini. 
Cdplayer.ini is a file in your Windows directory that records all the data for the Windows’ CD 
player. Simply copy this small file to a floppy disk and, after you’ve set up your new PC or hard 
drive, copy it into the new system’s Windows folder. The CD player on the new system will be 
able to read all the title and track info. 
You can also open this file with Notepad to edit the track listings directly without inserting the 
CD, if you like. 
 
079 - Dial M for Moving 
If you’re working in a folder Window and need to move it around but don’t want to have to reach 
for your mouse, hold down Alt and press the spacebar. 
This produces the System Menu, at which point you type m for Move. Then use your keyboard’s 
Arrow keys to transport the selected window anywhere on the screen you wish.  
 
078 - Hidden drives 
Want to hide drives with sensitive material on them from prying eyes? You can prevent any or 
all disk drives from being displayed in My Computer and Explorer. 
It takes some Registry tweaks, which can be tricky. Check instructions at www.WE-
Compute.com/registry.html if you are new to Registry editing. 
In the Registry navigate to 
HKEY__USER\Software\Microsoft\Windows\CurrentVersion\Policies\Explorer. Right-click on 
Explorer and choose New and DWORD value. In the pane on the right, rename the new value 
NoDrives and double-click on it to open the Edit DWORD Value box. Click the Decimal option 
to select it, instead of the Hexidecimal option. 
Now for the complicated part. To hide a drive or drives, a number that corresponds to the 
drive(s) must be entered. Enter the value listed below for the drive. If multiple drives are to be 
hidden, add the numbers for those drives together. For example, hiding drives D and E requires a 
value of 24, because you are adding the value for D (8) to the value for E (16), which equals 24. 
 
A: 1 
B: 2 
C: 4 



D: 8 
E: 16 
F: 32 
G: 64 
H: 128 
I: 256 
J: 512 
K: 1024 
L: 2048 
M: 4096 
N: 8192 
O: 16384 
P: 32768 
Q: 65536 
R: 131072 
S: 262144 
T: 524288 
U: 1048576 
V: 2097152 
W: 4194304 
X: 8388608 
Y: 16777216 
Z: 33554432 
All: 67108863 
 
These drives will still appear in File Manager, the file-managing utility left  over from pre-
Windows 95 days. So if you are hiding drives, deleting Winfile.exe may be a good idea, as well. 
Most users, though, are scarcely aware File Manager still exists. The hidden drives are also still 
accessible via a command prompt, as in DOS. 
The boot disk, usually the C drive, tends to show up in Explorer even if you hide it in My 
Computer. 
To bring back hidden disks, just change the value of NoDrives to 0 or delete the value altogether. 
 
077 - The right sort 
When you open a folder, Windows will usually sort the files available alphabetically, but it 
doesn’t have to be this way in Windows 98 and Me. 
To change the default way the files are sorted, open Windows Explorer, click View and select 
Details. Click one of the title bars, either Size, Type or date Modified. The one you select will 
determine how your list is displayed the next time you open a file. Once you’ve selected one of 
the bars, hold down the Ctrl key on your keyboard and click the X button in the top right corner 
of Windows Explorer to close it.  
You may have to restart your computer for this trick to take effect.  
 



076 - Explore from anywhere 
If you’re looking at files or folders in My Computer, Windows Explorer, or almost any other 
folder, and then realize you need to open a Web page, you don’t need to exit the folder and open 
Internet Explorer.  
In any folder that offers an address bar, just type the Web address there, click on Go (or press 
Enter) and you’ll go straight to the site, provided you are connected to the Internet.  
You should also find that your Internet bookmarks are available under the Favorites menu. 
 
075 - Keep on running 
Want to keep your computer running without anyone else being able to shut it down?  
Then disable the Shut Down command. Here’s how: 
Open your Registry Editor. (If you’re new to editing the Registry, check www.WE-
Compute.com/registry.html for instructions.) 
Go to HKEY_CURRENT_USER\ Software\Microsoft\Windows\Current 
Version\Policies\Explorer.  
Create a new value by clicking Edit and New DWORD value. Right-click the new value and 
select Rename. Type NoClose and press Enter. Double-click the new value and under Value data 
type 1 (one) to disable the Shut Down command.  
If at a later time you wish to re-enable shutdown, change the Value data to 0 (zero). 
 
074 - Broken arrows 
Do those crooked little arrows on your shortcut icons bug you?  
You can banish them by changing your Windows 95, 98 or Me Registry. (As always, be careful 
editing the Registry. Check www.WE-Compute.com/registry.html for instructions and 
precautions.) 
In the Registry Editor, go to the HKEY_CLASSES_ROOT key and look for the folder called 
"piffile". Click on it and, in the panel on the right, right-click on the value "IsShortcut". Select 
Rename and give it any new name you want. (We like WasShortcut, so we can remember where 
it’s located.)  
Still under HKEY_CLASSES_ROOT, find the folder called "lnkfile" (that’s a lower-case L at the 
beginning of the name). Perform the same operation on its "IsShortcut" value. 
Close the Registry Editor and restart the computer and...no more little arrows. 
If you miss them and want them back, just rename the values back to IsShortcut. 
 
073 - Screensaver that can’t be avoided 
So you use a password on your screensaver to prevent your family or colleagues from stopping it 
and accessing your computer when you’re absent. 
But then they discovered they can get past this obstacle by simply pressing the restart button on 
your computer. 
So now you need a higher level of protection: a password-protected screensaver that takes effect 
whenever Windows is started. 
First find out which screensaver your computer is using. Most of the default screensavers for 
Windows can be found in the C:\Windows\System folder. Screensavers usually have the .scr 
extension. For example, if you know you’re using the 3D text screensaver, its filename should 
read something like "3D Text.scr". When you find it, right-click on the file and select Create 
New Shortcut. 



After you have created the shortcut to the screensaver, move the shortcut to your Startup folder 
which can be found in your main Windows folder under the Start Menu and Programs sub-
folders.  
Make sure the screensaver is password protected. You can do this through the Display control 
panel on the Screen Saver page. 
From then on, every time someone starts or restarts your computer, they’ll come face to face with 
the screensaver and password again. 
 
072 - Yes, there is a use for that key! 
Ever wonder what the Pause/Break key on your keyboard is for? 
Well, we still don’t know what it was invented for - but we do know one thing you can do with it. 
Hod down the Windows key on your keyboard while pressing the Pause/Break button. 
Your System Properties control panel should open up. 
We have no idea what this has to do with Pausing or Breaking, but it’s a nifty shortcut. 
 
071 - Stalling technique 
Ever been downloading one of those really important files from the Internet and you’ve got about 
two minutes left when you get a message saying your download timed out?  
With the help of a little Registry edit, you can tell your computer to wait longer before giving up 
on a download. (If you are unfamiliar with editing the Registry, check out the instructions and 
precautions at www.WE-Compute.com/registry before attempting this.)   
In your Registry Editor go to 
HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\Class\Modem\(number of your 
modem, most likely 0000)\Settings. Click on the string value titled Inactivity Timeout and 
change the numbers in the brackets. For example, if you want your computer to wait 20 minutes 
for the stall to recommence, type a 20 into the brackets like this: S19=<20>. 
 
070 - Blacker than black 
Here’s a tip for desktop publishers or for anyone who produces work with graphics to be printed 
in a four-colour process, such as with commercial printers. 
Not all blacks are equal. Professionals have long known that some blacks are more solid, 
seemingly blacker than others. 
You can get denser blacks if you don’t colour objects with just 100-percent black. Add in the 
other process colours - cyan, magenta and yellow - up to 20 percent each if you like, although 
usually five percent is enough.  
The additional colours won’t be noticeable to the naked eye because the black will cover them, 
but they’ll help fill in the minute gaps in the black ink, so the eye will get an overall impression 
of greater solidity. 
A standard trick is to add a little magenta or red (magenta plus yellow) to get  a warmer, richer 
black. 
Adding cyan will create a crisper, cooler black. 
 
069 - The real update date 
The Web site says it’s updated daily, but somehow you don’t believe the page you’re seeing is all 
that new. How to find the truth? 



In the address bar where you usually enter the Web site URL, type 
javascript:alert(document.lastModified) without spaces and hit Enter.  
A window will pop up, telling you the time and date when the page was last revised. 
 
068 - Nowhere left to Run 
If you use Run on the Start menu much, it can create a long list of commands that can tell other 
users what you’ve been up to. You can clear this list with an edit to Windows’ Registry. (If you’re 
not familiar with editing the Registry, check out how at www.WE-Compute.com/registry.html.) 
In the Registry make your way to 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\RunMRU. 
Click on RunMRU to show this key’s values in the right pane. Select all except Default, right-
click and choose Delete from the pop-up menu. Close the Registry and restart the computer. 
Now there’s nowhere left to Run, until you enter more commands that start a new list. Sigh. 
This should work n Windows 95, 98 and Me. 
 
067 - Mouseless menus 
When you’re running an application, instead of clicking your way through the pulldown menus 
with your mouse, keep your hands on the keyboard.  
Press the F10 function key at the top of your keyboard and then navigate through the menus with 
your Arrow keys. 
This is one trick that works on both Windows and Macintosh computers. 
 
066 - Your own meter maid 
If you ever work on your Windows computer for long periods of time, you’ve probably noticed it 
seems to slow down after a while. If you want to really find out what’s going on, press your Start 
button and select Run. Type rsrcmtr in the Open box. Click OK.  
You now have your a Resource Meter that will tell you if your system is getting bogged down. 
Double-clicking on the green icon for the meter in the system tray will give you all the details.  
Computers often slow down over time because of the amount of RAM memory you have. The 
amount of RAM memory is always much less than what is in your hard drive and it thus doesn’t 
take long to use up most of it. Once you restart your computer however, it’s like charging your 
batteries, you’re all ready to go again. Just keep in mind that the Resource Meter uses your 
resources too. 
If you look in your system tray in the bottom right corner of your screen, you’ll find a lot of 
applications that you may not need running. Some programs like RealPlayer will be open down 
there even though you’re not using it. Double-clicking or right-clicking the icon should show 
you options for closing the program and freeing up system resources. 
 
065 - Site lines 
Windows 98 and Windows Me let you keep a folder of Favorite sites on the Start menu, but even 
without this you can place a quick link to your favourite Web site by itself on your Start menu. 
Go to Settings on your Start menu and open Taskbar (also called Taskbar & Start Menu). Click 
on the StartMenu tab and on the Add button. Then type in the Internet address, such as www.we-
compute.com. 
Hit Next and then choose where you want it located — for instance, highlight Start Menu if you 
want it there. Hit Next again and now give it a name. Click on Finish and on OK. 



Now, whenever you click on the name you gave the site on your Start menu, it will open your 
Web browser and prepare to go to the site. 
 
064 - Numbing the NumLock 
Windows 95 and 98 have a nasty habit of starting your computer with the NumLock key on.  
If you want it off from the start, open the System Editor which can be found by pressing Start, 
and selecting Run. In the Open box, type sysedit and click on OK. You will then find a program 
with a few cascading windows. Select the window with the title C:\CONFIG.SYS in the title bar.  
In an open line at the bottom of this page type an extra line which reads NUMLOCK=OFF and 
press the Enter key. Save the file, by selecting Save from the File menu. Then select File and 
Exit. The next time you start Windows your computer should have the Number Lock feature off.  
If you later decide that you would like the NumLock back on, change the line to read 
NUMLOCK=ON. 
 
063 - My Logo 
Are you tired of seeing that spinning globe in the corner of Internet Explorer? You can change it 
to a graphic you’ll be happier with. This can be a picture you create yourself using Paint or 
another program — or you can use a file you may already have.  
The key here is to make sure your graphic is 26 pixels high by 26 pixels wide. You may even 
want to put a little picture of your face up there, or your loved one, be it human or animal. Save 
the graphic as a bitmap file (with the .bmp extension) and remember where you saved it. 
To make this graphic your new IE logo, you have to tweak the Windows Registry. If you’re not 
familiar with this process, check out the instructions and precautions at www.WE-
Compute.com/registry.html. 
In the Registry Editor, go to HKEY_CURRENT_USER\Software\Microsoft\Internet 
Explorer\Toolbar. Select Toolbar, right click on it and select New and String Value. When the 
new value is created in the right pane, rename it SmBrandBitmap and double-click on it. Under 
Value Data type the full path to the graphic that you saved and click OK. Exit the Registry Editor 
and restart your computer. The next time you start Internet Explorer you should have a new logo 
to enjoy. 
Your graphic will not spin like the globe but that may be a good thing for many people. 
However, it is possible to replace the logo with an animated bitmap graphic too if you know how 
to create such a image. You can find such images on the Internet at freeware and shareware sites. 
 
062 - Switch hitter 
When you've got several tasks running or several folders open in Windows 95, 98 or Me, you 
can switch among them without resorting to your mouse to click on the taskbar.  
Instead hold down the Alt key and hit the Tab key. A box appears showing an icon for each open 
program.  
Keep holding down Alt and tap the Tab key to move the selector rightward from program to 
program. Or hold down the Shift key with Alt and hit Tab to move left. 
 
061 - Cheatin’ Hearts 
If you play Hearts, the game that comes with Windows (called Classic Hearts in Windows Me), 
this trick will help you win by letting you peek at your opponents' cards. 



It requires a clever little Registry tweak and a little knowledge of a certain science fiction classic. 
(For instructions and precautions for editing Windows’ Registry, see www.WE-
Compute.com/registry.html.) 
In the Registry, make your way to 
HKEY_CURRENT_USER\Software\Microsoft\Windows\Current Version\Applets\Hearts. If 
you do not have a Hearts key, it’s because you have never played it on your system and the 
Registry has not set one up yet. In that case, play the game once and then go back to the Registry 
to find this key. 
Select the Hearts key and right-click in the pane on the right side of the window. Choose New 
and String Value from the pop-up menus. Rename the new string ZB - which some fans of the 
SF novel A Hitchhiker’s Guide to the Galaxy might recognize as short for the character Zaphod 
Beeblebrox. 
Double-click on the new value to bring up its Edit String dialogue box. In the data field, enter the 
great answer to the question of life, the universe and everything - at least according to A 
Hitchhiker’s Guide.  
You don’t know? Okay, the answer is the two-digit number 42. Enter that, click OK, close up the 
Registry and start Hearts. 
During the game, press the Ctrl, Alt, Shift and F12 keys all at once and you’ll see everyone’s 
cards. 
 
060 - Nowhere to Run 
If you use Run on the Start menu much, it can create a long list of commands that can tell other 
users what you’ve been up to. You can clear this list with a Registry edit. 
(For information on editing Windows’ Registry see http://www.WE-Compute.com/registry.html.) 
In the Registry make your way to HKEY_CURRENT_USER\Software\Microsoft\Windows\ 
CurrentVersion\Explorer\RunMRU. Click on RunMRU to show this key’s values in the right 
pane. Select all except Default, right-click and choose Delete from the pop-up menu. Close the 
Registry and restart the computer. 
Now there’s nowhere left to Run, until you enter more commands that create a new list. 
 
059 - Clean and mean 
First off, Windows takes way too long to launch. In the second place, you usually end up with a 
rack of icons for all kinds of programs and utilities, half of which you probably didn’t know you 
have, in the Taskbar across the bottom of the screen. All these items are coded to start when 
Windows is launched, thereby slowing you down. 
And, if you think you can just delete these startup items from your Startup folder, you’ll be 
disappointed. Many of these startup items are not found there. 
But wait, if you’re running Windows 98 or Me, you have another place where these startup items 
can be turned off. 
It’s Window’s System Configuration Utility. You can usually find it by clicking on the Start 
button, clicking on Run, entering msconfig and hitting OK. 
When the System Configuration window opens, select the Startup Tab and just uncheck 
programs you don’t want Windows to load. Click on OK to close the utility and your next startup 
should be faster and leave you with a cleaner Taskbar. 
 



058 - Show-and-tell icons 
This trick makes thumbnail pictures of your bitmap files (those graphic files ending in .BMP) 
appear in Windows Explorer - so you can see what the images look like without opening them 
first. 
This involves editing the Windows Registry which can be tricky, so check instructions at 
www.WE-Compute.com/registry.html if you are new to this. 
 This trick may not work immediately on every PC. If you have your .BMP files assigned to be 
opened by Corel PhotoPaint or some other image-editing program, you may have to play with 
those settings before the Registry revision takes effect. 
In the Registry, open HKEY_CLASSES_ROOT. Scroll way down to Paint.Picture and double-
click on it. Select DefaultIcon. 
On the right side of the screen, double-click on Default and, in the window that pops up, change 
the value to %l (that’s a percent sign followed by a numeral one with no spaces) and click on 
OK. Close the Registry. 
Open Explorer and you should see the bitmap files represented by thumbnail images. You may 
have to restart the computer first. 
 
057 - Tweak and ye shall find 
When you right-click on Windows’ Start button to select Find, the search takes place by default 
in C:\Windows\StartMenu - which is a ridiculous place to look - unless you change the location 
manually.  
You could also access Find by right-clicking on the My Computer icon and selecting Find, but in 
this case the hunt will begin in My Computer, which likely makes for a broader search than you 
need. 
How can you change the find default to something more useful, like the C: drive? 
You need to tweak Windows’ Registry. (If you’re new to this, check out Registry-editing 
instructions and precautions at http://www.WE-Compute.com/registry.html.) 
In the Registry, go to HKEY_CLASSES_ ROOT\Directory\shell\find\ddeexec. In the right pane, 
double-click on Default which has a string value of "[FindFolder("%1", %1)]".  
In the Edit String dialogue box, replace each %1 with the location where you want to start the 
Find. For example, to make the C: drive the default search location, enter [FindFolder("C:\", 
C:\)] and click on OK.  
Close the Registry and the change should take effect right away. 
 
056 - The disappearing drives trick 
Why would you want to remove drive icons from the My Computer folder? Because you never 
use them. Or maybe to play a prank and make a friend think his or her drives are missing. 
Whether you want to use this trick for good or evil, here’s how: 
In the Registry, work your way to 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Explorer. In 
the right pane, right-click and select New and DWORD value. When the value appears in the 
right pane, rename it NoDrives and double click on it to open its Edit DWORD Value window. 
Enter 3FFFFFF in the space provided and make sure Hexadecimal is selected. Click OK. 
The next time the computer is restarted, My Computer will have no drive icons in it. 
To get the icons back, return to the Registry to delete the NoDrives value. Reboot and everything 
will be back to normal.  



 
055 - Heavy task, man  
Way back in the pre-Windows 95 world, there used to be something called the Task Manager, 
which let you select among current jobs you were running on your system and align their 
windows on your screen. 
Guess what? It’s still there, hidden in Windows 95, 98 and Millennium Edition. 
To activate it, click on Start and Run, type taskman in the space and click on OK. 
In the Tasks dialogue box are wide buttons for each current application. Click on them and 
choose commands from the menus to run the applications, minimize their windows or tile them. 
Hold down the Ctrl key as you click to select more than one. 
 
054 - Scheduled shutdown 
You can schedule Windows 98 and Windows Me to do a lot of things by using the Scheduled 
Tasks utility that comes with the operating system - but you can’t make it shut down at a certain 
time. 
Unless, that is, you know a little trick. 
This is a great trick for when you want to let the computer finish a task, like burning a CD or 
backing up, but you don’t want to hang around waiting for it to be done so you can manually turn 
it off. 
In Windows 98 or Millennium Edition, click on the Start button, Programs, Accessories, System 
Tools and Scheduled Tasks. Double-click on Add Scheduled Task and then click on Next. 
Browse in the Windows directory until you find the file RUNDLL.EXE and select it.  
In the next window, pick "One time only" and click on Next. Choose the time you want to shut 
down and click Next and then Finish. 
But you’re not finished yet.  
Double-click on the task you’ve created and, in the window that appears, change RUNDLL.EXE 
to c:\Windows\RUNDLL.EXE user.exe,exitWindows (there’s only one space in the command - 
before user - and those are backslashes around the first Windows). Click on OK and now your 
computer is ready to shut down on schedule. 
Some users may find that this trick works better if they use RUNDLL32.EXE in the command 
instead of RUNDLL.EXE or if they type \system\user,exitWindows instead of 
user.exe,exitWindows. 
 
053 - History buffer 
Want to quickly go back to a site you were on last night? If you have Web History on your Start 
menu, you can do this. Here’s how to set it up: 
Right-click on the Start button and select Explore. You should land in Windows Explorer with 
the Start Menu folder open within the Windows folder. Right-click in the right pane and select 
New and Folder from the context menu. This creates an item called New Folder. Click to select 
the name and type Web History.{FF393560-C2A7-11CF-BFF4-4445 53540000} as its new 
name. (There are no spaces, there is a period after "History", those funny brackets are found 
above the square brackets on your keyboard, and those are zeros - not letter O’s - in the long 
string of characters.) Press Enter and the folder name will collapse to "Web History". 
Close Explorer, click the Start button and you’ll find Web History on the menu. 



Now you can select from this menu any site previously visited online. Provided your Internet 
connection is set up properly, your browser will open, you’ll log on, and you’ll go right to that 
Web page. 
 
052 - What’s your chip speed - really? 
How do you know for sure what your computer’s processor speed is - without taking the machine 
apart and checking the actual chip? 
Windows Me shows the official chip speed in the System Information section but with Windows 
98 you have to play a small trick to get a similar statistic. In Win98, click on Start, Programs, 
Accessories, System Tools and System Information. Then, under the Tools menu, select 
Windows Report Tool. Click on Change System File Selections near the bottom. 
The computer will whir away for a few seconds collecting information and then present it in a 
window called Collected Information under the heading "System settings to copy". It includes all 
sorts of technical data about your system, including operating system, CPU type, memory, hard 
disk usage, Bios type, card and modem models - and the processor’s speed.  
This does not just parrot the official clock speed but tells you what your processor is currently 
running at, which is usually somewhat less than the maximum. 
 
051 - Win every time 
Freecell is one of the card games you get with Windows. Even if you don’t know how to play it, 
you can win in a jiffy with this trick. 
During the game, hold down the Ctrl and Shift keys and press the F10 function key. You’ll be 
asked if you want to Abort, Retry or Ignore. Select Abort and instantly all the cards will be 
placed down and you’ll be declared king of Freecell. 
If you happen to choose Retry, you’ll immediately lose. 
Or, if you’re a real beast for punishment, here’s another way to lose: Launch the game and press 
the F3 function key (or choose Select Game from the Game menu). You’ll be asked which game 
you want to play. Type in -1 or -2 and you’ll be given a card layout that hides all the aces at the 
back, making it impossible to win. 
 
050 - Command performance 
If you’re an oldtime computer user who still messes around in DOS, you may be frustrated that 
you can’t access Windows 95 and 98’s shortcuts when you’re working in this venerable operating 
system. 
But you can! The trick is in the wording. 
The command is the word start followed by the path to the file with the .lnk extension added to 
it.  
Suppose you have a shortcut on the Windows desktop named Nonsense. The command will be 
start c:\windows\desktop\nonsense.lnk to launch it Windows. 
If the filename includes spaces, as in Shortcut to Nonsense.exe, you have to wrap quotation 
marks around the whole pathname, as in start "c:\windows\desktop\shortcut to 
nonsense.exe.lnk". 
 
049 - The cure for wandering hands 
This is especially a problem in Windows 98: You click on the Start Menu, maybe the Programs 
menu, then an application group and then another cascading menu with the specific program you 



want and then, before you’ve had a chance to pick the item you want, you let your mouse hand 
wander a little and the next thing you know a completely different submenu has popped open and 
the wrong item selected. Arrgh! Sometimes Windows is just too accommodating in grabbing 
menus your cursor meanders near. 
But you can tame this tendency. 
Open the Registry Editor. (If you don’t know how, you can find simple instructions - and 
important precautions - at www.WE-Compute.com/registry.html.) 
Navigate to HKEY_CURRENT_USER\Control Panel\Desktop and click on Desktop to show its 
values in the right pane. Look for a string named MenuShowDelay. If it’s not there, you can 
create it by right-clicking on Desktop and selecting New and String Value. Double-click on 
MenuShowDelay to open the Edit String dialogue box and change the value to 65534 before 
clicking on OK. 
Close up the Registry and restart the computer. 
Now when you click on a menu, it stays open, even if you accidentally wander near another one. 
Actually what you have done is changed how long it takes before a menu is activated without 
being clicked on - you’ve made it take over a minute (65,534 milliseconds), which is much 
longer than you are likely to idle in any one place. 
A downside to this is that none of the menus you do want will open automatically now either. 
You have to click on each one. 
But for those of us with wandering hands, the trade-off is worth it. 
 
048 - New gateway to your files 
If you have Internet Explorer 4 or better installed on your Windows 95/98 system, you can have 
a quick gateway to your folders and their files. Here’s how to set it up. 
On your desktop, left-click on the My Computer icon and drag it all the way to the left of the 
screen. Release the mouse button and the contents in that folder will cascade, as a menu, down 
the left side of your desktop. Now left-click on the C: drive icon in that menu, and drag it up to 
the middle of your screen, all the way up to the screen edge. Release the mouse button. 
Now you have a cascading menu across the top of your desktop, listing all the folders and files in 
your C: drive. 
But you likely have too much content for that little menu, in which case you’ll see two tiny right-
pointing arrows at the far-right of that menu bar. Click on those to get the cascade to continue 
down the right side of your desktop. And if you hover your mouse over any of those folders 
cascading down the right, another menu will explode out, showing you the folder’s contents. 
While this trick does cut down on your desktop space, you can now efficiently get to any of your 
files, right from your desktop.  
And if you don’t like this arrangement, just right-click on an empty spot of each menu and 
choose Close. 
 
047 - Putting commands in context 
With a bit of fiddling of the Registry, you can make an official-looking message pop up on a 
computer screen as a user starts or logs onto Windows. 
To get into the Registry, hit Start and Run, type regedit and click on OK.  
(For detailed instructions and precautions about editing the Registry, go to http://www.WE-
Compute.com/registry.html.) 



In the Registry Editor, navigate through the following keys: 
HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\Current Version\WinLogon. Right-
click on WinLogon and select New and String Value. Rename the string value that appears in the 
right-hand panel LegalNoticeCaption and then double-click on it. In the Edit String box that pops 
up, enter a short title for the logon message you want to create and click on OK. 
Right-click again on WinLogon and make another new string value, named LegalNoticeText this 
time. Double-click on this string value and in the Edit String box enter the full message, as you 
want it to appear. Click on OK. Close up the Registry Editor and reboot the computer. 
You should see the message. 
Since we’re in a pranksterish mood, we recommend you perform this trick on a computer 
someone else uses. Give a friend an authoritative-looking notice from Microsoft, saying that due 
to his poor computing skills, he is henceforth banned from using Windows! 
 
046 - Elementary, Watson 
The great sleuth’s famous sidekick is available in your computer, prepared to help you track 
down problems with your system: Dr. Watson has been part of Windows through several 
versions but most users don’t realize it. 
If you’re having computer problems, give the good doctor a try. 
First you have to make Dr. Watson active. In Windows 95 you can probably find the file 
drwatson.exe in the System folder within your Windows folder. In Windows 98 it’s usually 
directly in the Windows folder. In Win98 you can also activate it by going through the Start, 
Programs, Accessories, System Tools and System Information menus and then selecting Dr. 
Watson from the Tools menu. The Dr. Watson icon should appear on the taskbar in the lower-
right corner of your screen. 
You can also put a shortcut to drwatson.exe in your Startup folder to have it automatically 
activated whenever you boot your computer. 
To get a report on the current status of your system and possibly suggestions on how to fix any 
problems, just click on the Dr. Watson icon on your taskbar and select Dr. Watson from the pop-
up menu. 
You can also use Dr. Watson to keep log of ongoing problems and refer to this information when 
you contact a help desk by phone or on the Internet. 
 
045 - Putting commands in context 
When you right-click on a folders in Windows, a menu pops up giving you several options, such 
as Open, Explore and Find. But you can add almost any other command you like to this context 
menu. 
To do this you need to edit Windows’ Registry. (If you are unfamiliar with the Registry, be sure 
to check the instructions and precautions at http://www.WE-Compute.com/registry.html.) 
In the Registry, make your way to HKEY_CLASSES_ROOT\Directory\shell. Right click on the 
shell key and select New and Key from the brief menu that appears. Name the new key whatever 
you want the new command to be. For example, if we want to be able to launch Microsoft Word 
from folder context menus, we might enter Word as the key name. Then right-click on the new 
key (Word in our example) and again select New and Key. This new key should be named 
Command. Click once on the new Command key and in the pane on the right double-click on 
(Default). 



In the Edit String dialogue box, enter the path to the file as the Value Data. In our case, the path 
would be C:\Program Files\Microsoft Office\Office\Winword.exe, but you can make a path to 
any other program, file or shortcut on your system. 
Click on OK, close up the Registry Editor and press F5 to refresh the Registry. Right-click on 
any folder on the desktop or in Explorer and your new option will be available. 
 
044 - Colourful browsing 
The Internet can be colourful all right, but your Internet Explorer browser provides a pretty dull 
frame for it all, doesn’t it? 
But you can easily brighten it up with the pattern or picture of your choosing. 
It just takes a little Registry tweaking. (If you’re not familiar with Windows’ Registry, see 
http://www.WE-Compute.com/registry.html for instructions and important precautions.) 
In the Registry, make your way to HKEY_CURRENT_USER\Software\Microsoft\Internet 
Explorer\Toolbar. Right-click on Toolbar and create a New String Value named BackBitmapIE5 
(if you’re running a version of IE earlier than 5.0, the value should be just BackBitmap). 
Double-click on the new string value to bring up its Edit String dialogue box. In the Value Data 
field enter the pathname to the bitmap (that is, to a file with a .BMP extension) you want to use, 
such as C:\Windows\Bubbles.bmp. You’ll find lots of such files in the Windows folder where the 
desktop wallpapers are kept. 
Click on OK to close the dialogue box and launch Internet Explorer. 
Bye-bye to grey-flannel browsing. 
You may have to experiment with various graphics before you get one that’s attractive but also 
the right colours to read icons and menu titles against.  
 
043 - Even up your columns 
In Windows Explorer, are some columns in the right pane too narrow to display the full 
information? But others are wasting space by being too wide? 
Of course, you could adjust each column individually, fiddling with the title tabs at the top of 
each column until you get each one just right. 
Or…you could simply select any file in the list by clicking on it once, hold down the Ctrl key 
and press the plus sign (+) on your keypad. All the columns will adjust automatically to fit their 
widest item! 
 
042 - Extend your selection skills in Word 
When you want to select text in Microsoft Word, do you sweep across it with your mouse? And 
then get mixed up or lose your place when the selection runs beyond the text showing in the open 
window?  
Several alternatives make it a whole lot easier to select text. Here are three of them: 
1. Place the cursor at your starting point in the text. Hold down the Shift key and press the Arrow 
keys. Text will be selected in the direction of the Arrow keys. 
2. Click on the starting point. Scroll to near the end point, hold down Shift and click on where 
you want to end the selection. 
3. Click at the starting point. Then double-click on the greyed-out EXT in the status bar below 
the window you're working in. Navigate to your intended end point and click on it. This is using 
Word's Extension Mode, which stays in effect until you double-click on EXT again to turn it off. 
These tricks work in all versions since Word 95 at least. 



 
041 - Most Excel-ent racing game 
This may replace the game in Excel 97 as the best Easter egg we’ve ever seen. 
It requires Excel 2000, Internet Explorer 5 and a recent version of DirectX. (Direct X  is 
probably already on your system if you play games, but you can also download the latest version 
for free from the Microsoft Web site.) 
First launch Excel 2000. Under the File menu, select Save as Web Page and change the name of 
the file-to-be-saved to whatever you like, ending with .htm. Click on the Publish button and in 
the new dialogue box, check off Add Interactivity. Click on Publish again. 
Close Excel and open IE5. Under File, select Open, hit the Browse button and find the .htm file 
you saved from Excel. The blank spreadsheet will appear on the screen in the browser window. 
Scroll down the spreadsheet to row 2000 - this will take some time. Then click on the number 
2000 to highlight the entire row. Press the Tab key repeatedly to move the selected cell on the 
highlighted row across the screen until the cell in the WC column is selected. (If you go too far, 
hold down Shift and press Tab to go back.) 
Hold down the Shift, Ctrl and Alt keys and click on the Microsoft Office logo in the upper left 
corner of the spreadsheet. 
In a few seconds your screen should go black and a car racing game will materialize.  
Use the Arrow keys to drive your car, hit the Spacebar to fire at cars in front of you, press the O 
key to drop oil slicks to foil the cars behind you and, when it gets dark, press H to turn on your 
headlights. 
 
040 - No Go logo 
It’s a small matter but it can be annoying - that animated logo some company stuck in the upper-
right corner of your browser, in place of the Netscape or Internet Explorer logo. 
But it’s easy to get rid of this unwanted promotion. 
Find the Internet Explorer or Netscape folder on your system. Look in it for files ending in .BMP  
and with names that seem related to the company whose logo is intruding. And delete them. 
It’s that simple. Open your browser and only Netscape or IE will be advertising for free in the 
corner of your browser. 
 
039 - Booting into DOS 
Long before Windows 95 or 98, there was Microsoft’s Disk Operating System, MS-DOS. In fact, 
DOS is still on your Windows computer. You can sample it by clicking on Start, Programs and 
MS-DOS Prompt. Or you can start your computer in DOS, by clicking on Start, Shut Down and 
Restart in MS-DOS mode. 
But if you really prefer DOS, you can start in it every time you boot your computer. 
Open Notepad (click on Start, Programs, Accessories and Notepad). Select Open from the File 
menu and change Files of Type to All Files (*). Then open the file msdos.sys which is probably 
in the C: root directory. 
Look for a line that says BootGUI=1 and change it to BootGUI=0 (that’s a zero). Save the file 
with this change. 
The next time you start your computer, you’ll be launched into DOS instead of Windows. You 
can always get back into Windows by typing exit at the prompt in DOS and pressing Enter. 
 



038 - More than one way to stop a disk scan 
As mentioned last week, some Windows 95 and 98 systems will scan the hard drive for problems 
whenever they are shut down improperly - even if the shutdown is caused by Windows itself. 
You can prevent this with a tweak to the msdos.sys file. 
But if tweaking system files makes you nervous, here’s another way of accomplishing the same 
end (the end of useless disk scanning, that is). 
Click on Start and Run. Type msconfig and hit OK. This opens Microsoft’s configuration utility. 
Click on the Advanced button and check the box labelled "Disable Scandisk after bad 
shutdown".  
That’s it. No more time-consuming scans. 
It’s so simple, it makes you wonder why the configuration utility is kept such a secret. 
 
037 - No more pointless disk scans  
If you use Windows 98 or a late version of Windows 95, you’ll find the system scans the hard 
drive for problems every time you start it after it was shut down improperly. 
But it hardly ever finds a problem with the hard disk. Ninety-nine percent of the time, the illegal 
shutdown was caused by Windows itself crashing! Yet that Scandisk process is launched and 
slowly checks your hard drive until you get fed up and click on Exit. 
But you can prevent the scan in the first place. 
Start Notepad and open the Msdos.sys file in your root directory. At the end of the [Options] 
section of the file, add the line AutoScan=0 (that’s a zero) and resave the file.  
The Msdos.sys file may resist this, claiming to be a read-only file, in which case you should first 
rename the old file to something like Msdos.old, make the revision and save your new file as 
Msdos.sys. 
Now the next time, Windows shuts you down unexpectedly, it won’t further punish you by 
making you sit through a pointless disk scan. 
And if you find this trick too much trouble, we’ll tell you another way to accomplish the same 
results next week. 
 
036 - Get more info  
If you used a PC before Windows 95, you may remember the MSD utility that gave you all kinds 
of information about your Windows 3.1 or DOS system. Too bad Win95 or 98 doesn’t have a 
similar program, eh? 
But it does, it does!  
Using Explorer, look in your Windows\MSApps\MSInfo folder for a file called MSInfo32.exe. If 
it’s not there, try looking in Program Files\Common Files\Microsoft Shared\MSInfo).  
Double-click on it to open it. You’ll find MSInfo gives you tons of info about your system and its 
components, including type of system, total memory, available memory, available space on each 
of your hard drives, swap file size, system DLLs, font substitutions and much, much more. 
 
035 - Can’t remember your Windows password? Fugeddaboddit! 
If your Windows computer has been set up to require a password when you log on, there’s a good 
chance you may not recall which to use. But this need not be a disaster. 
Upon being asked for the password, click on Cancel. You’ll end up in Windows anyway, 
although not with your personalized settings. Click on Start, Programs and MS-DOS Prompt. In 
the DOS window, type DIR *.PWL (with a space after DIR only) and press Enter. You’ll get a 



list of files ending in .PWL, one of which probably starts with a reasonable facsimile of your 
name, like SANDYMIL.PWL if you’re Sandy Miller. Delete it with the command DEL followed 
by a space and the filename, as in DEL SANDYMIL.PWL. 
Close the DOS window and restart. You’ll be asked for a new password. 
 
034 - Stump the panel 
You can create shortcuts to most files and programs in Windows, as well as to Control Panels. 
But many Control Panels have multiple pages, so your shortcut won’t link directly to the page 
you want. 
Or will it? We know how to do this with at least one control panel. 
Suppose you want to make a shortcut to the Screensaver page of the Display control panel to let 
you switch screensavers quickly. Right-click on an empty area of the desktop and select New and 
Shortcut. For command line, enter control.exe desk.cpl,display,1 with a space only beween exe 
and desk. Click on Next, type in a name for the shortcut and click on Finish.  
You can also make the shortcut go to other pages of the Display control panel by changing the 
number at the end of the command line. For example, changing the 1 to 0 will call up the 
Background page and changing it to 2 will bring up the Appearance page. 
 
033 - Clean up as a minesweeper - again 
So your friends eventually caught on to your cheating in Minesweeper using the winmine.ini-
editing trick you learned here last month? That’s okay, because now we’ve got a new trick you 
can pull to beat Windows’ built-in game and rack up record-breaking times. 
Launch the game and click on a square to start the timer. Then click both the left and right mouse 
buttons simultaneously on any square. You’ll see a nine-square indentation. Still holding the 
mouse buttons down, press the Esc key. 
This stops the clock and lets you complete the game at your leisure while recording an incredibly 
low time. 
 
032 - A classy new Recycle Bin 
Previously we’ve shown how to rename your Recycle Bin, how to get rid of it, how to get it back 
and how to add commands to its context menu. Now, in what’s gotta be the last Recycle Bin trick 
ever, we show how to redecorate it - that is, how to change its appearance on your desktop. 
Simple, you think. Just right-click on it, select Properties and click on the…wait a minute, there's 
no option to change the icon. 
Why Microsoft would think the appearance of a garbage can is so sacrosanct that they won't let 
you change it is beyond us. 
But we can outfox them by tweaking Windows' Registry to change the icon. (As usual, if you're 
new to Registry editing, check out the instructions and precautions at  
www.WE-Compute.com/registry.html.) 
In the Registry Editor, make your way to HKEY_CLASSES_ROOT\CLSID\{645FF040-5081-
101B-9F08-00AA002F954E}\DefaultIcon. When you click on the subkey DefaultIcon, you 
should see one to three string values in the right pane. At least one will be named Default and 
you may have two others called Empty and Full. Their values will be something like 
"C:\Windows\System\Shell32.dll, 31", or ending with "32". This means the 31st or 32nd icon in 
the file Shell32.dll is being used as the Recycle Bin graphic. 



To change this, double-click on the name of the string value (such as Default) and in the Edit 
String dialogue box enter the filename and number of the icon you want to use. For instance, to 
get a blue triangle, you would enter C:Windows\Moricons.dll,66 and click on OK. 
How did we know that the 66th icon in the Moricons.dll file is a triangle? 
On the desktop, we right-clicked on a shortcut (any shortcut), chose Properties, clicked on the 
Shortcut tab and again on the Change Icon button. In the dialogue box, we entered 
C:Windows\Moricons.dll as filename and pressed Enter. A long line of icons appeared and we 
cursored over 66 places (counting the first icon as zero) until we found the triangle design. 
Of course, we already knew moricons.dll was a file of icons. Other such files are Shell32.dll in 
the System folder and Iconlib.dll which may be somewhere on your system. 
When you’ve made the changes to your Registry for Default, Empty and Full, close the Registry 
Editor. Restart your computer or press F5 a few times to refresh your desktop. 
 
031 - Log off, fella 
It’s simple to remove that "Log Off" item from above "Shut Down" on Windows’ Start menu by 
tweaking the Registry. (For instructions on editing the Registry, see www.WE-
Copute.com/registry.html.) 
In the Registry Editor, go to 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Explorer. 
Right-click on Explorer and select New and Binary Value. 
Rename the value NoDriveTypeAutoRun. (If there’s already one with this name, leave it and go 
to the next step.) Then double-click on the value to bring up a dialogue box. Enter the figures 95 
00 00 00. There may already be four zeros there. The eight digits you add will fall in place after 
them. You don’t need to space them, as they will automatically group themselves into four pairs. 
Right-click on Explorer again and create another New Binary Value. This time, name it 
NoLogOff and edit the value to read 01 00 00 00. 
The next time you start Windows, the Log Off option will be gone. 
 
030 - Power surfing 
Here’s something even many longtime Web surfers don’t know: You can download pages 
simultaneously in multiple browser windows. It can be much faster than downloading one page 
after another in the same window. 
So, if you have several sites you want to visit quickly, enter the URL (Web site address) for the 
first one and start your browser looking for it, then open a new browser window (probably by 
clicking on New or New Window in the File menu) and start it looking for the second site, and 
so on. Then, when all the pages are downloaded you can jump from one to another quickly by 
switching windows. 
Or suppose you find a Web page that has many links you want to check out. You could wait for a 
page to download and jump back to the original site, download another page and jump back, ad 
nauseam. But it’s much faster to right-click on a link, select "Open in New Window" (this is 
found in both Netscape and Internet Explorer) and then, as soon as the page starts to download in 
a separate window, go back to the first window, right-click to open the next link in a new 
window, and so on, until all the links you want to check are downloading at the same time. 
And here’s one more secret of power browsing: You can even download simultaneously with 
different browsers. So you can access a site that works well with Internet Explorer at the same 
time as you download a Netscape-friendly page. 



 
029 - Clean up as a minesweeper 
Through various versions of Windows, Minesweeper has been a great time-waster - and people 
have found various ways to cheat their way to impressive scores.  
Find the game by clicking on Start, Programs, Accessories and Games. If it’s not there, you didn’t 
install the included games with Windows, but you can add it to your Windows installation at any 
time. 
Here’s how to get scores to impress your friends - without even playing the game. Look for the 
file winmine.ini in your Windows directory. (You may have to play the game a few times to 
have this file created.)  
Open the file with Notepad. You’ll find listed "Times1=", "Times2=", "Times3=", each followed 
by a number. These are the three fastest scores, which you can change to whatever very low 
times you like. Below them are "Name1=", "Name2=" and "Name3=", each followed by a 
player’s name, corresponding to the respective times. Change them each to your name. Save and 
close the file.  
Now when anyone checks the best scores, they’ll find your incredibly fast times.  
 
028 - Back to big 
Last week in "Smaller is better" we came up with three ways to minimize all your open windows 
at once. So this week we need three ways to get back all the windows you have minimized with 
any of those methods. Here they are: 
1. Click on the Show Desktop icon again next to your Start button, if you have one. (It’s a 
Windows 98 feature.)  
2. Right-click on a blank space on the taskbar across the bottom of your screen and select Undo 
Minimize All from the context menu.  
3. If you have a Windows keyboard, hold down both Shift and the Windows keys, and press M. 
 
027 - Smaller is better  
How many ways can you come up with to minimize all your open windows at once? 
We can think of three: 
1. Click on the Show Desktop icon next to your Start button, if you have one. (It’s a Windows 98 
feature.)  
2. Right-click on a blank space on the taskbar across the bottom of your screen and select 
Minimize All Windows from the context menu. 
3. If you have a Windows keyboard, hold down the Windows key (the one with the Windows 
symbol on it) and press M. 
 
026 - Compressing the Programs menu 
Do you have so many programs that they don’t all fit on the Programs menu off the Start Menu - 
so you have to scroll from the bottom of the Programs menu to find items near the end (in 
Windows 98) or the menu cascades right across your screen (in Windows 95 or in Win98 
adjusted in an earlier Cheap Trick to get rid of scrolling)? 
It’s a simple matter to compress this menu to make it easier to work with. All you have to do is 
group programs together. For instance, put all your Microsoft applications (and who doesn’t have 
a lot of these?) under one listing, like "Microsoft apps", with submenus flying out for the 



individual programs. Or you could group your programs according to function, putting all your 
layout, drawing and image-editing programs under "Graphic design apps". 
It’s easy to do. 
Right-click on the Start button and choose Explore. The active folder should be Start Menu. If 
not, look for it in the Windows directory and open it. In it, select the Programs folder, and the 
contents of that folder will appear on the right side of the Explorer window.  
Now, from the File menu, select New to create a new folder under the Programs folder. Type a 
name for the new folder (like Microsoft apps), and drag the shortcut icons for related programs 
(Microsoft Word, Excel, FrontPage, Outlook, etc.,) from elsewhere in the Programs folder into 
this Close Explorer and on the Programs menu now you’ll have a single folder with a fly-out 
menu for the related programs. Do this for various groupings of programs until you have your 
Programs menu down to manageable size. 
 
025 - Time passes quickly 
QuickTime is a great plug-in that almost everyone has on their system to run multimedia clips, 
especially while on the Internet. If you haven’t installed it yourself, some software that you’ve 
used has probably installed it on your system during its own installation. 
But odds are QuickTime is configured too slowly for your modem - which makes for longer-
than-necessary QuickTime downloads. Or it may be set for a speed that’s too quick for your 
modem and computer system to handle efficiently. 
You can check this in your control panel called QuickTime or QuickTime Settings. In the control 
panel, select Connection Speed from the drop-down menu and click on the speed that 
corresponds to your modem. 
On four machines we checked it on, Quicktime was set for 28.8/33.6 Kbps instead of 56K to 
match the modem capabilities. 
 
024 - Searchin', searchin'… 
As mentioned in a recent Cheap Trick of the Week, you can narrow down your search in most 
search engines by using the title prefix. For instance, if you enter title:aardvark in search engines 
such as Yahoo, HotBot, AltaVista, InfoSeek and Excite, you’ll get results that include only those 
with the word "aardvark" in their Web site title, such as "The Aardvark Page". 
But now two more search tips are revealed. 
You can also use the url prefix to select only sites that have the word in their URLs (Web site 
addresses). So url:aardvark will turn up results like www.souprecipes.com/aardvark.html. 
Or use the domain prefix to narrow your search to domains, such as .com, .org, .ca and so on. For 
example, a search on aardvark domain:.org  might turn up www.exoticpets.org/aardvark.html. 
In Yahoo, the title and url prefixes can be shortened to t and u, as in t:aardvark and u:aardvark. 
 
023 - Escaping the 'hood 
Do you ever use that Network Neighbourhood icon on your Desktop? If your PC is not on a 
network, you don’t really need it. So get rid of it. 
Right-click on it and…hey, there's no Delete option! 
So, you'll have to use the heavy artillery -  a Registry hack. (If you're new to Registry editing, 
check www.WE-Compute.com/registry.html for more instructions and precautions.) 
In the Registry Editor, go to 
HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Explorer. If 



the Policies or Explorer keys are missing, create them by right-clicking on the previous key, 
selecting New and Key, and giving the new keys their proper names.  
Click on the Explorer key to view its values in the right pane. If there is not a value named 
NoNetHood in the right pane, create it by right-clicking on the Explorer key, selecting New and 
DWORD Value. In the right pane, NoNetHood should have a value data of 0x00000000 (0) next 
to it. Double-click on NoNetHood and a dialogue box will appear allowing you to edit the 
DWORD value. In the Value Data space should be a single zero. Change it to a 1 and click on 
OK. Now the data figure beside NoNetHood should be 0x00000001 (1).  
Close the Registry, reboot and you’ve left the hood. 
 
022 - Window to the past 
If you’re old enough to fondly remember Windows 3.1 - or if you’d just like a peak at what 
computing was like pre-1995 - you may be interested to know the Windows 3.1 File Manager 
(forerunner of Windows 95/98’s Explorer) is still available on your current system.  
And you can use it while running 95 or 98. 
The most direct way to bring it up is to click on your Start button and on Run, type winfile and 
click on OK. The File Manager will pop up. 
If you like it enough to want it instantly available at all times, you can make a shortcut to it on 
your desktop. To do this, right-click in an open space on the desktop. In the context menu that 
pops up, select New and Shortcut. A dialogue box appears and you should type 
C:\Windows\Winfile.exe into the Command Line field (assuming Windows is the folder where 
Windows 95 or 98 is installed on your system). Click on Next and then name the new icon 
something like The Ol’ File Manager and hit Finish. 
Now whenever you want to relive the Windows 3.1 days, you can just click on the The Ol’ File 
Manager icon. 
 
021 - Windows in DOS 
If you ever work in the DOS window accessed from the MS-DOS Prompt of Windows 95 or 98, 
you probably occasionally wish you could quickly display a directory in Windows’ folder style 
without exiting DOS altogether. 
It’s easy. In the DOS window, at the prompt type start . (the word start followed by a space and a 
period) and hit Enter or Return. A folder will open over the DOS window, showing icons for the 
current directory. 
To get a folder display of the parent of the current directory, use start .. (start followed by a space 
and two periods). Now you’re getting the best of both worlds: DOS’s command structure and 
Windows’s graphics. 
But, wait, you can go further in mixing the two realms. 
While in the DOS window, you can also run a Windows application. At the prompt enter start 
pathname in which pathname is the name of the application, including its directories and 
extension. For example, start \windows\sol.exe might be the command you use to launch a game 
of Solitaire. 
You can even open a Windows document with start filename in which filename includes the path 
and file extension. 
Remember to use DOS’s truncated filename style without spaces. To open a letter named "Send 
money.doc" in the My Documents folder, your command in DOS would be start 
\mydocu~1\sendmo~1.doc.   



 
020 - The wandering Start button 
Here’s one for Windows 95 users. 
If you think the Start button always has to be at the left end of your taskbar, then try this: 
Click on your Start button, then press Alt and the hyphen key (the key to the right of the zero) 
together. Choose Move from the menu that pops up. The cursor now appears as a crosshatched 
cursor. Using the left and right arrow keys, you can now slide the Start button across your 
taskbar. 
It will appear to "ghost" across your screen - hit Return when you’ve positioned it where you 
want it, and it will look normal again. (Of course, its positioning will be anything but normal.) 
Repeat the above process to move it to another spot, or back to its original location. 
 
019 - Windows of opportunity 
This is one of those little tricks that are not all that spectacular but, once you get used to them, 
you find yourself using them all the time. 
You’re typing away and you realize you want to make the window you’re working in larger or 
smaller. 
Naturally you reach for the mouse and drag the bottom-right corner of the window to a new 
position to stretch the box. 
But you could resize the window without taking your fingers off the keyboard. 
Hold down the Alt key and the Spacebar and press the S key. A four-pointed cursor appears on 
screen. Press any two arrow keys (cursor keys) and the window will expand in those directions.  
Press the opposite arrow keys and the window will shrink.  
Press Enter when you’ve reached the size you want, or Esc to cancel the resizing. 
 
018 - You’re entitled to a better Web search 
Here’s a tip to make your online experience better. 
Suppose your pet aardvark is sick and you want to know how to help it get better. So you type 
aardvark into a search engine on the Web…and you get 659,157 matches, including 1,450 
cooking sites. 
You need to narrow your search to sites that are serious about aardvarks.  
Enter title followed by a colon and then your search term. For example, try title:aardvark and 
you'll get sites with the animal in their title - not necessarily in their URL, but in their official 
title, like "The Aardvark Page" or "The Care of Pet Aardvarks". 
Using the title prefix increases the likelihood that the sites found by a search engine really have 
to do with the subject. 
This trick works for several search engines like Yahoo, HotBot, AltaVista and InfoSeek, though 
with Yahoo you can also just use the letter t with a colon, as in t:aardvark. 
 
017 - Non-Starter 
Here's another nasty, but harmless, stunt to pull on a friend who uses Windows 98: Make their 
Start button disappear.  
Hold down the Ctrl key and press Esc. Press Esc a second time. Then hold down Alt and press 
the hyphen (-). In the menu that appears, select Close by pressing the DownArrow key and 
hitting Enter. 
Button, button, where's the Start button? 



After your friend’s had a good scare, you can restore the Start button.  
Press Ctrl, Alt and Del together. In the Close Program dialogue box that appears, select Explorer 
and click on the End Task button. You’ll get another dialogue box that asks if you really want to 
shut down your computer. This time click on No. A few moments later another dialogue box 
appears. Click on End Task again and the Start button will be back. 
 
016 - Bringing shareware back from the dead 
You install a shareware program you want to try, but you don’t get around to it until after it 
expires. So you have to download it all over again, right?  
Wrong. If you still have the installation file, you can just reinstall it. 
Oops, this doesn’t seem to work - the program is still timing out. Now you’ve got to go back to 
the Web to download it again, right? 
Wrong again. The shareware programmer has made the program create a small file on your 
system to record the first installation date. You’ll find it somewhere on your computer with an 
".ini" extension. Don’t confuse it with other .ini files your computer needs to operate properly. If 
you can’t tell from the file name, you can open the file with a text editor and see if the contents 
give you a clue - just be sure to close it without resaving. 
If you find the proper .ini file, you can just delete it and reinstall the shareware program. 
If the .ini file is not to be found, the clever programmer may have hidden the initial installation 
date in Window’s Registry. If you know your way around the Registry you can delete this entry 
in there. (See www.WE-Compute.com/registry.html for an intro to Registry editing.) 
 
015 - Return to sender 
That was a neat trick last week to add new items to the Send To submenu, wasn’t it? But it was 
so long and laborious. 
So this week’s trick makes it easier to add destinations to the Send To list. You just have to know 
how to add "Send To" to Send To. 
It’s not as crazy as it sounds. 
In Windows Explorer, find the Send To folder under Windows just as you did last week. Click 
once on it, so it opens in the right pane. Still in the left pane of Explorer, right-click on the Send 
To folder and drag it into a blank area in the right pane and let go. In the small menu that pops 
up, select Create Shortcut(s) Here. This places an item called Shortcut to Send To right in the 
Send To folder. You can rename it something like Add to the Send To Menu. 
Now whenever you want to add another destination to the Send To submenu, you can just right-
click on the file and select Send To and then Add to the Send To Menu. 
One minor hitch. This tends to move the entire file into the Send To folder. If you want to leave 
the original file where it is, first right-click on it and select Create Shortcut. Then right-click on 
the shortcut to send this to Add to the Send To Menu. 
 
014 - You really send me 
The Send To command, which you get by right-clicking a Windows icon and selecting Send To 
from the context menu that appears, is so handy. You can quickly shoot a file off to your floppy 
drive, Zip drive or a few other destinations that appear by default on the Send To submenu. 
It’s even handier if you add your own destinations to the Send To submenu, so you can send files 
anywhere you like. You can send them to another drive, to another folder on the hard drive, to 
the Desktop or even to an application to open them. 



Here’s how to set this up: 
Open Windows Explorer. See that Send To folder within the Windows folder? Remember where 
it is.  
Now find in Explorer the icon and name for the new destination you want to add to the Send To 
menu - whether it be a drive, a folder or a program ending in ".exe". In the right-pane of 
Explorer, right-click on the icon and choose Create Shortcut. You can rename the newly created 
shortcut to however you want it to appear on the Send To submenu. 
Now drag this shortcut into the Send To folder you had noted earlier in the left pane of Explorer. 
Now, whenever you right-click on a file anywhere in Windows, you’ll have the option of firing it 
off to that new destination. 
 
013 - Imaginary email 
Here’s another delicious but harmless practical joke you can pull on your fellow computer users. 
Now you can send email to a friend or colleague from any email address and domain name you 
can think up. For example, you could send a message to a young woman friend from 
LeonardoDiCaprio@hollywoodstars.com asking her to join him on a cruise. Even funnier, send it 
to a male friend! 
We’re sure you could come up with even better pranks. All in good fun of course. 
How to do this? Go to the Web site http://www.groundskeeping.com/fun.html and just fill in the 
blanks. 
But remember to use this trick, like other Cheap Tricks, only for good, not for evil. 
To make sure you don’t abuse this power, the webmaster at this fun site checks every message 
before it is sent out. 
 
012 - Quick exploring  
Most likely your Windows 95 or 98 system is set to open folders in the My Computer style with 
icons representing folders and files. But you can easily open any folder in the two-pane Explorer 
style.  
The usual way to do this is to right-click on the folder and select Explore from the context menu.  
Here’s a faster method: Just hold down the Shift key while double-clicking on the folder. 
 
011 - Garbage by any other name 
Your Recycle Bin does not like to be renamed or deleted, and so it does not offer the Rename or 
Delete option on its context menu (which you get by right clicking on the icon). 
But you can add these options if you dare fiddle with your Windows 95 or 98 Registry. 
To edit your Registry, click on Start and Run, type regedit and click on OK. This opens the 
Registry Editor. (See http://www.we-compute.com/registry.html for more detailed instructions 
and precautions for editing the Registry.) 
Navigate through the following keys: HKEY_CLASSES_ROOT\CLSID\{645FF040-5081-
101B-9F08-00AA002F954E}\ShellFolder. With ShellFolder selected, double-click on the 
Attributes value in the right pane. In the Edit Binary Value window that appears, replace the 
eight digits "40 01 00 20" with 70 01 00 20 and click on OK. 
Close the Registry Editor and right-click on your Recycle Bin to see your new choices. 
 



010 - Scrap it 
With Windows 95 and 98, you can save a portion of text or graphics from a document into a 
separate file by simply highlighting the text or graphic in the original file and dragging it onto 
the desktop. This creates a "scrap" which you can later drag into another file where it will 
automatically insert itself. 
This may sound like a roundabout way of copying and pasting between documents, but the 
advantage is that you can save multiple scraps this way and they stay on your desktop until 
needed - even days later. 
Try this with various text or graphics programs. 
 
009 - Explore where you wanna explore 
After you right-click the Start button and select Explore, Windows’ Explorer opens by default in 
the Start Menu in the Windows directory - leaving you to find your way out of there to the file 
you. 
But you can set up your own version of Explorer to open more quickly to the directory of your 
choice. Or several versions of Explorer starting in a selection of directories. 
First, find the file explorer.exe in your Windows directory. Drag the icon onto your desktop. This 
will leave the file in the Windows directory but create a shortcut to it on the desktop. Right-click 
on the shortcut, select Properties and click on the Shortcut tab.  
In the Target field, you’ll see an entry like: 
C:\WINDOWS\EXPLORER.EXE  
Add a space and "/e" to the end of this, so you end up with: 
 C:\WINDOWS\EXPLORER.EXE  /e 
The "/e" parameter makes your new Explorer window open with two panes, just like in the 
default Explorer. Without this parameter, the window would look like the opened My Computer 
folder. 
Below the Target field, you’ll see that the Start Menu probably listed in the Start In field. Replace 
this with the path to whichever directory you prefer Explorer to open with; for example, 
C:\MyFiles 
Click on OK. Then back on the desktop you can rename the shortcut - for instance, to Explore 
MyFile.  
Now whenever you double-click on the Explore My File icon, Explorer will open at the directory 
you’ve chosen. 
You can create as many such shortcuts as you like, giving yourself quick-clicking exploration of 
all your often used folders.  
You can even change the icons of these shortcuts from the My Computer-style computer graphic 
to the Explorer-style magnifying glass. In the same Properties window for each such shortcut, 
click on the Change Icon button to get some alternative icon designs. 
 
008 - Recall your Web site passwords 
Are too many Web sites requiring passwords for you to remember them all? 
A solution could be to make a Web site’s password appear automatically whenever you go to that 
site. 
In Netscape, start by bookmarking the site whose password you want to remember. Then under 
the Bookmarks menu, select Edit Bookmarks. Right-click on the appropriate bookmark and 
select Bookmark Properties. Click in the Location field and go to the end of the address. In most 



cases you can simply add a question mark (?) followed by your password or any other 
information you would like to append, all without any spaces. When you next use this bookmark 
to go to the Web site, the additional information will appear on the address bar. The browser will 
ignore everything from the question mark on, but you can read it to pick up your password. 
If the bookmarked address is one of those long, complicated ones with equal signs, pluses or 
other strange characters, you may have to use an ampersand (&) instead of the question mark. 
In Internet Explorer, the process is almost identical. Mark the site as a Favorite, look under 
Favorites for Organize Favorites, right-click the item, select Properties and add your info with a 
question mark or ampersand to the URL field. 
 
007 - A fate worse than the Blue Screen of Death 
What’s the worst thing that could happen to a devoted Windows user?  
How about finding that his or her computer has suddenly been changed into a Macintosh? 
So here’s a nasty but harmless trick you can play on a fellow PC owner - to make them believe 
this bizarre event has actually happened to them. 
Tell your friend you’ve got a great Web site to show them on their Windows computer. Then 
direct them to www.yaromat.com/macos8/index.htm with their Web browser. 
Before they can stop it, the computer will start scrolling up messages indicating their Windows 
system is being replaced by the Macintosh operating system. It’ll even appear to boot up like a 
Mac and give them a screenwide desktop identical to the Mac’s.  
If your (former) friend frantically clicks on the Mac-style desktop icons they’ll find a memory 
game to play and may eventually discover how to restore the appearance of their screen to the 
usual Windows design.  
(Hint: Check out the trash.) 
 
006 - The name game 
Here’s a Registry trick we keep getting asked to repeat: 
When you buy a new computer, you’ll often find Windows 95 or 98 is installed as registered to 
the name of the store or to something generic, like "Customer" or "XXXX". How do you change 
that to your name, without reinstalling Windows? 
You can do this by editing your system’s Registry. (If you are unfamiliar with editing the 
Registry, look for instructions and precautions at http://www.WE-Compute.com). 
Hit the Start button, type regedit  and click on OK to open the Registry Editor. Make your way 
through the keys to HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\Current 
Version. When you click on CurrentVersion, you should see RegisteredOwner in the right pane. 
Double-click on its icon and in the Edit String window type the name you want to appear as the 
registered owner. Hit OK and close up the Registry. 
You can also change the company name by editing the string for RegisteredOrganization. 
 
005 - Desktop à la carte 
Your Windows 95 or 98 desktop is covered with open folders but you want to get to a desktop 
shortcut without minimizing the folders. How? Simply click on the Start button and on Run, then 
type a period in the space and click on OK. A small window will open, containing just your 
desktop folders and shortcuts. (If the window covers your whole screen, click on the second icon 
in from the top right corner of the window to tile it, and next time it’ll open smaller.) 



This is especially handy in Win95, since this older operating system does not have a desktop 
icon on the taskbar at the bottom of the screen as Win 98 does. However, this trick can be useful 
in Win 98 too, because clicking on that desktop icon minimizes all your open folders and returns 
you to the full desktop - and sometimes you don’t want the hassle of later having to re-open all 
your folders in the same order they were in before you went to the desktop. 
 
004 - Screen out your screensaver 
Sometimes you leave your desk for a while but you don’t want the bother of having your 
screensaver take over. But you don’t want to permanently disable your screensaver either, 
because sometimes you do want it to come on and hide your work. 
So, to temporarily prevent your screensaver from coming on, simply click the Start button once 
and walk away. 
The Start menu will stay open indefinitely, preventing the screensaver from activating. 
 
003 - Sit up and shut down 
This is one of WE Compute’s most popular Cheap Tricks ever. 
Windows 95 and 98 have almost turned shutting off your computer into a 12-step program. 
You have to click on the Start button, click on Shut Down, select Shut down again and click on 
OK. And the computer is still on. You have to wait until it tells you it’s okay, and then you can 
actually push the various buttons on your PC, monitor and printer to turn them off. 
But you can set things up so at least the first part of the operation is reduced to click-click. 
Right-click on your Windows 95 or 98 desktop and, in the menu that pops up, choose New and 
Shortcut. In the dialogue box that appears, type the command line C:\windows\rundll.exe 
user.exe,exitWindows with a space before user only. (This assumes your Windows 95 or 98 
directory is called Windows. If not, substitute the real directory name for windows in the 
command line.) Click on Next and name the new shortcut something clever like "Shut Down". 
Click on Finish.  
Now a "Shut Down" icon appears on your desktop. Double-click on it and you’re out. That fast. 
Note: This trick works with the systems we’ve tested it on, but a few users have found it works 
for them better if they use rundll32.exe in the command line instead of rundll.exe.  
And at least one reader has found he has to revise the line to C:\Windows\rundll.exe  
\system\user,exitWindows for the trick to work. 
 
002 - The first Windows 98 Easter egg 
Like many Easter eggs, this one shows off the software’s developers. But it’s not a simple list of 
names - it’s a little multimedia slide show. Also unusual is that you can find this hidden treat in 
two different ways. 
Method #1: 
Double-click on the time in the tray at the right end of your Windows 98 taskbar. Click on the 
Time Zone tab to take you to the map of the world. Figure out, maybe with the help of an atlas, 
where the following cities are located: Cairo, Egypt in northeast Africa, Memphis in the 
southeast United States and Redmond (home of Microsoft) in the American northwest. Now hold 
down the Ctrl key all the way through the next steps. Click on the Time Zone map where Cairo 
should be and, holding the mouse button down, drag the cursor to where Memphis is. Let go of 
the mouse button, without moving the cursor. Press the button again and drag the cursor from 



Memphis to Redmond. Let go of the button and you can also release the Ctrl key now. The show 
should be starting. 
You may have to try this several times before you get the positions exactly right to make this 
trick work. 
Method #2: 
Find the file Weldata.exe. It should be in your Windows directory, in the Application 
Data\Microsoft\Welcome subdirectories. Right-click on the file and select Create Shortcut. Click 
on the Shortcut tab. In the Target box, type a space after what’s there already and add 
You_are_a_real_rascal (don’t leave out the underscores between the words) to the end of what’s 
in there already. In the Run box, select Minimized. Click OK to close up the dialogue box. To 
start the show, just click on the shortcut. 
 
001 - Serve yourself 
Windows 95 or 98 users can check what servers they’re connected to when they’re online. 
While connected to the Internet, click on the Start button, Programs and MS-DOS Prompt. MS-
DOS will open in a separate window with the Windows directory showing. Just type netstat at 
the prompt and hit Enter. After a few seconds a list will pop up with the servers you are 
connected to and the state of the connection. 


